Pro Tools M-Powered 8.0.1 on Windows

This Read Me documents important compatibility information, known issues, error codes, and corrections to the guides for
Pro Tools M-Powered 8.0.1 on Digidesign-qualified Windows systems running a Digidesign-qualified version of Windows.
For the latest compatibility information, visit the Digidesign website (www.digidesign.com).

Installation Issues

Pro Tools Cannot Launch (ltem #58531)

Pro Tools will not launch if hardware drivers are not installed or if there are no Inputs or Outputs set in the M-Audio Control
Panel. If Pro Tools does not launch, be sure the M-Audio drivers were installed before Pro Tools installation. If the drivers are
installed, go to the M-Audio Control Panel and make sure either the Analog or S/PDIF Inputs and Outputs are enabled.

The Delta Driver Control Panel Defaults to No Audio Output Because the Output Faders are Set to —Infinity (Minus Infinity)
(Item #60160)

The Delta driver Control Panel defaults to no output fader gain because the output faders are set to —-Infinity (minus infinity).
To hear audio, you need to change the gain in the Control Panel.

Compatibility

Digidesign can only assure compatibility and provide support for Digidesign-qualified hardware and software configurations.
For a list of Digidesign-qualified computers, operating systems, and third-party devices, refer to the latest compatibility in-
formation on the Digidesign website (www.digidesign.com). Check the M-Audio website (www.m-audio.com) for updated

drivers for your unit.

Database File Compatibility

Pro Tools 7.x requires a new Digidesign database file format. Database files created with Pro Tools version 6.x will be deleted
upon launching Pro Tools 7.x for the first time. Please re-index your drive(s) for faster searches. Refer to the Pro Tools Reference
Guide for information on indexing DigiBase databases.

Increased Number of Characters in Memory Locations Comments Field (Iltem # 83593)

In Pro Tools 7.3 and higher, the number of characters allowed in the Comments field for Memory Locations has been in-
creased. When opening Pro Tools 7.3 and higher sessions in previous versions of Pro Tools, any characters beyond 258 will
be dropped from the Memory Locations Comment text.

Opening the FireWire 1814 Control Panel Causes Computer to Crash or the Screen to Turn Blue (Item #57675)

The FW1814 Control Panel does not support AGP video Hardware Acceleration and Write Combining enabled. Having these
items enabled can cause the computer to crash. Go to Display Properties > Settings > Advance > Troubleshoot, and set Hard-
ware Acceleration to None, then disable “Enable write combining.” When the settings have been updated, you can open the
FireWire 1814 Control Panel without causing a crash.
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M-Audio Hardware Compatibility with Sony VAIO Machine (Item #58084)

There are known compatibility issues with installing M-Audio hardware drivers on some types of Sony Vaio computers. Please
refer to the M-Audio customer support site for the latest updates on system compatibility.

Compatibility with Wireless Network Card and M-Audio Hardware (ltem #58435)

Using a wireless networking card with Pro Tools can cause noise to be output from your hardware. To avoid this, you should
disable your wireless networking card.

Aero Causes Errors at Lower HW Buffer Sizes (Vista Only) (ltem #103563)

With Aero enabled in Windows Vista, Pro Tools will not play back without errors at HW Buffer sizes of 128 and below. Turn
off Aero if you want to use lower HW Buffer sizes.

Automatic Update Notification (Item #108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain
internet access. To workaround this, the client machine with Software Updater needs to be moved out from behind the proxy
or the proxy needs to allow HTTP access via port 80 without requiring authentication.
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Known Issues

The following sections document known issues you may encounter when using Pro Tools M-Powered 8.0.1, along with work-
arounds if they exist.

For known issues specific to the Music Production Toolkit 2 option for Pro Tools M-Powered, see the Music Production Tool-
kit 2 Read Me.

Pro Tools

Default Drive Defragmenting Task Corrupts Audio Files (Vista Only) (Item #111562)

If Pro Tools is allowed to sit open and idle after 12:00 AM on Wednesdays, Windows Vista will run a scheduled disk defrag-
mentation task at 1AM which can result in corrupted session or audio data. Digidesign recommends either disabling the
scheduled disk defragmentation task or making sure Pro Tools is not open if a scheduled disk defragmentation task is pend-
ing.

Vista Systems Do Not Support Double-Clicking to Launch Pro Tools Session or Installer on External FireWire HFS+ Drive
(Item #98779)

On Vista systems, if the session or installer is located on an external FireWire HFS+ drive, you cannot double-click on it to
launch the session or installer. To launch a Pro Tools session located on an HFS+ drive, launch Pro Tools first, and then use
the Open Session command in the File menu to open your session. For Pro Tools installation, copy the installer onto an in-
ternal drive, and run the installer from there.

Windows Erroneously Reports that Pro Tools has Stopped Responding (Vista Only)

Clicking on the splash screen while Pro Tools is launching can result in a Windows Vista error stating that Pro Tools has
stopped responding. Pro Tools is actually still loading normally and will finish launching if you just don’t do anything or if
you click “Wait for the Program to Respond.”

Templates Retain 1/0 Settings and Some Preferences, Display Settings, and Window Layouts (ltem #111605)

Pro Tools Session Templates Retain the I/O settings and some of the preferences, display settings, and window layouts from
the system on which the template was created. Consequently, created a new session based on a template restores several ses-
sion properties from the original system. These properties are retained by Pro Tools until you change them or another session
or template is opened that replaces them. This also means that if a new blank session is created after using a template, the
properties from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup.
You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the
“Install template in system” option), and then selecting the template you want to replace.

Opening Session Created with Pro Tools 7.4 or Lower (ltem #: 106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.0.1, all waveform overviews are recalculated. This
is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This re-
calculation only needs to happen once.

Possible Performance Issues with New Waveform Overviews (ltem #110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.0.1 may cause some one time issues with various operations. Once the over-
views are calculated, system performance will return to normal. Areas where you may notice this are:

Legacy Sessions (Item #110041) When opening Legacy Pro Tools sessions for the first time, if you immediately start play-
back, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to remove some
RTAS plug-ins. This is due to the fact that Pro Tools is re-calculating of the session’s waveform overviews in the background.
Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calcu-
lated, you will not experience this issue again.
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Playback of Newly Created Regions (Iltem #106801 and 106577) You may notice a slight drop in normal playback perfor-
mance immediately following a record take or after creating or importing new regions. This is due to the fact that Pro Tools
is calculating waveform overviews in the background, and is mostly only encountered when recording or creating many re-
gions with long durations. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once
the waveform is calculated, your session playback performance will return to expected levels.

Some Sessions that use Reason with ReWire Don’t Open in Pro Tools 8.0.1 (Item #111757)

Opening some Sessions that contain Reason ReWire will result in the following Reason error: “Engine not responding. Please
check your ReWire host.” To workaround this problem, launch Pro Tools and create a new session. Then, insert Reason Re-
Wire on any track. Close the session, but keep Reason open. Then, open the session that uses Reason with ReWire that you
couldn’t open before.

On Vista Systems, Start+L Launches the Switch Admin User Prompt Instead of Nudging Cursor to the Left (ltem #98665)

On Vista systems, Start+L Key launches the Switch Admin User prompt instead of nudging the cursor to the left. As a work-
around, enable Keyboard Focus (A...Z) and use the L key.

CPU Usage Limit May Be Reached when Error Suppression is Enabled (ltem #83343)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point
at which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppres-
sion is enabled.

Screen Redraw May Slow Down at Higher CPU Usage Limit Settings when RTAS Error Suppression is On (ltem #82915)

In some cases, you may experience a slowdown in screen redraw or background CPU tasks when RTAS Error Suppression is
engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using RTAS Error Sup-
pression, open the Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent.

Software Instrument does not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (Iltem #65797)

Some software instruments will not emit sounds and will not play. If this occurs, manually assign a hardware input to the In-
strument track or Auxiliary Input, and/or manually assign a MIDI output to the Instrument.

Dropped Region Loops when Saving Sessions as Pro Tools 5.1 to 6.9 Format (ltems #90102, 90079)

When saving a session as a 5.1 to 6.9 format, a dialog appears informing the user that “Region Loops will be dropped.” As a
workaround, highlight all audio files and choose Region > Unloop > Flatten before saving the session as a lower version of
Pro Tools.

Audio Regions on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo
(Item #96710)

Audio regions on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different
from the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input
and the regions will play back correctly.

Import Audio Incorrectly Splits a Stereo Interleaved WAV file that contains IXML Metadata into Two Separate Mono Tracks
(Item #98841)

Import Audio incorrectly splits a stereo interleaved WAV file that contains IXML metadata into two separate mono tracks.
Please use the workspace instead to drag the file into the Edit window or directly onto a stereo track.

ASIO Client with Windows Media Player (Item #60117)

If you are playing audio from an M-Audio device using Window Media player, ASIO client applications cannot launch. To
play audio from both the ASIO client and from Windows Media Player, quit out of all applications and then launch the ASIO
client first.
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MP3 Codec Exports Non-Copyright Files Only (Item #68985)

The MP3 codec in Pro Tools 7.3 and higher does not have the ability to encode an attribute for the file to be copyrighted. This
is a limitation of the codec from Fraunhofer.

Importing MP3 or MP4 Files without QuickTime Installed (Iltem #62994)

If Pro Tools has been run on a system on which QuickTime was not present, but then QuickTime is installed later, there is the
possibility that Pro Tools has indexed QuickTime files as “Unknown.” These files will remain as unknown even after Quick-
Time has been installed. If this occurs, either delete Digidesign Database files and try again, or navigate in the browser to any
“Unknown” QuickTime file and select “Update Database for Selected.”

Conversely, if Pro Tools has been run on a system with QuickTime present, but then QuickTime is uninstalled, there is the
possibility that QuickTime files have been indexed as known audio file types that can no longer be understood by Pro Tools
since QuickTime is now absent. If this occurs, delete all database files and try again.

Issues with Kensington Mouse and Drivers

The following may occur when using a Kensington mouse with Pro Tools:
e Alt key sticks when Zooming (Item #61823)
e Stuck Shift Key (Item #62376)
¢ Stuck Control Key (Items #61830, #62066, #61980, #61988, #62348, and #62559).

To clear stuck keys, press them again. If problems continue, remove the Kensington drivers.

Windows Security Alert During Launch (ltem #62060)

While launching Pro Tools, the following dialog may appear: “Windows Security Alert. To help protect your computer, Win-
dows Firewall has blocked some features of this program.” This is to be expected. This dialog can be dismissed and it will not
affect Pro Tools performance.

Pro Tools is Not Compatible with Surround Audio in QuickTime Movies (ltem #67350, 67351, 67353)

QuickTime 7 introduced the ability for QuickTime movies to have surround audio. Currently, Pro Tools is not compatible
with QuickTime movies that have more than two channels of audio. Pro Tools cannot import from, or bounce to, multi-chan-
nel QuickTime movies. Also, the audio in multi-channel QuickTime movies is not recognized in the Workspace browser.

Pro Tools Loads Until “DAE Loaded” Message, But Never Launches (ltem #56701)

Disabling all of the Inputs and Outputs in the M-Audio Control Panel can cause Pro Tools to not launch. Go to the M-Audio
Control Panel and make sure the S/PDIF or Analog Inputs and Outputs are enabled before launching Pro Tools.

Pro Tools Application Freezes after Disconnecting M-Audio Device (ltems #58951, #95255)

If the M-Audio device is disconnected while Pro Tools M-Powered is running, Pro Tools will let you save the session, but will
freeze during quit. In general, do not disconnect M-Audio devices while Pro Tools M-Powered is running. If for some reason
the device gets disconnected, the current session can be saved normally. However, Pro Tools may need to be forced to quit
afterwards by using Alt+F4 or Control+Alt+Delete. After a forced shut down, Pro Tools M-Powered can be re-launched as long
as the M-Audio device has been reconnected. The host computer does not need to be rebooted in this case.

Screensaver Disables Output Gain Control on M-Audio FireWire Hardware (ltem #59203)

If the screensaver activates while running Pro Tools M-Powered with the M-Audio FireWire 410, the FireWire 410 output gain
controller may become disabled. Output gain can still be controlled from the M-Audio FireWire Control Panel. It is recom-
mended that the screensaver be disabled when running Pro Tools M-Powered in order to avoid this issue.
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Distortion, Pops or Clicks in the Audio (or DAE Errors) when Recording at 96 kHz with a 128 Buffer Size (Items #57617 and
#57614)

On 2 GHz or slower CPUs, distortion, pops, or clicks (or DAE errors) can occur during recording or playback when the session
sample rate is at 96 kHz and the Hardware Buffer Size is 128. Try increasing the H/W Buffer Size if this occurs. If this does not
fix the problem, switch to a lower sample rate.

Changing Sample Rates During a Session Can Cause Session to Play at a Higher or Slower Speed (ltem #56697)

Changing Sample Rate during a session from the M-Audio Control Panel can cause the audio to playback at the incorrect
speed. Consequently, the data could be unrecoverable afterwards. Before creating a session, set the Sample Rate in the
M-Audio Control Panel and do not make changes thereafter.

When External Sync Changes Sample Rates, FireWire 1814 Driver Can Lose Current Sample Rate (Item #58741)

On FireWire 1814 interfaces, when the external sync changes its sample rate, the M-Audio hardware driver can sometimes get
confused about the current sample rate. For instance, the dialogue “The current playback engine does not support a sample
rate of 44.1kHz” is posted when opening 48kHz session after switching Sample Rate from 48kHz to 44.1kHz and back to
48kHz on an external device with S/PDIF outs.” The workaround is to get the sample rate of the external device stabilized to
what you want, exit Pro Tools (to release the M-Audio driver completely), then restart Pro Tools and open your session.

M-Audio FireWire Devices can Fully Reset or Hang when Device is Locked to External Device via SPDIF and Sample Rate
is Changed to a Higher Sample Rate (ltem #59481)

If an M-Audio FireWire device is locked to an external device via SPDIF, changing the sample rate of the external from
44.1k/48k to 88.2k/96k while Pro Tools M-Powered is open, will cause the FireWire device to perform a full reset causing
Pro Tools M-Powered to become non-responsive. The workaround is to make sample rate changes prior to launching
Pro Tools M-Powered.

Error Message “Could Not Complete Your Request Because the System Cannot Find the File Specified (2)” (Items #50454
and #50457)
This message can appear while logged into a non-administrative account and doing either of the following:

e Performing destructive AudioSuite processing

¢ Locking files in the Workspace browser

This is possibly because the audio file has read-only permissions. In order to correct this, you must be able to log into an ad-
ministrative account in Windows XP and change the permissions of the audio file so you have full read and write access to
the audio file. If you do not have administrative access of the computer, then you must either contact the administrator of
the computer to resolve this problem, or use the File > Save Copy In command to create a copy of the session with all of its
audio files.

Error Message “Could not Complete the Bounce to Disk Command Because Access is Denied” (Iltem #50488)

Bouncing to disk to the root level of any SCSI drive while logged into a non-administrative account may cause the following
error: “Could not complete the bounce to disk command because Access is denied.” This is because Windows XP doesn't al-
low files to be created at Root level of a drive while logged into a non-administrative account. To get around this problem,
you must create a sub-directory and redirect your session bounce to the newly created directory.

Recalculating Overviews while Logged into a Non-Administrative Account (ltem #50537)

Recalculating overviews of audio files while logged into a Non Administrative account may cause the following error in the
task window in Pro Tools: “Access denied. (5).” This is probably caused by the audio files having read-only permissions.

In order to correct this, you must be able to log into an administrative account in Windows XP and change the permissions
of the audio file so you have full access to the audio file.

If you do not have administrative access of the computer, then you must either contact the administrator of the computer
to resolve this problem, or use the save copy as feature of Pro Tools, and create a copy of the session with all of its audio files.
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Performing Commands which Require Saving a Session on a Non-Administrative Account (ltem #53335)

When logged in as non-administrative user, and opening a session which was copied from CD-ROM (or external hard drive)
onto the system, executing any command which causes Pro Tools to save the session will cause the Access to be denied. To
resolve this problem, first save the session with Save As or Save Session Copy In.

Importing Tracks with Import Session Data Clears the Undo Queue (ltem #51775)

It is documented in the Pro Tools Reference Guide that importing tracks through Import Session Data clears all the undo queue.
The undo queue gets cleared when Main Playlist Options is set to “Import - Replace existing playlists.” The undo queue does
not get cleared if the option is set to “Import - Overlay new on existing playlists” or “Do Not Import.”

Intermittent Shuttle Lock Commands Ignored (Item #47155)

Shuttle Lock commands occasionally seem to be ignored. Click once on the Transport pop-up and the functionality will re-
turn.

Automation Window Update when Writing Automation (Item #111105)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no in-
dication that automation on the related control is being written. You will need to observe the automation buttons on tracks
in Mix or Edit windows to see an indication that automation is being written.

File Management

System Crash on Startup with Macintosh Formatted FireWire Drives (ltem #45288)

After installing MacDrive, mount Macintosh formatted FireWire drives only after Windows has finished starting up. Starting
up with FireWire drives connected after installing MacDrive causes a system crash.

Loss of Sharing Information when Unmounting Drive from Pro Tools Workspace (ltem #46273)

Information relevant to the Shared Folders and Permissions for a given drive, or the folders within it, is lost when a drive is
unmounted from within a Pro Tools workspace.

Missing Files when Opening a Session Created by an Earlier Version of Pro Tools (ltem #37572)

When opening some sessions created by an older version of Pro Tools, some files may be missing. You should be able to relink
these files in the Relink window by Name and Duration. In some cases Match Format may not result in found links.

“Access Violation” on Playback of Read-Only Sessions

Pressing play in a session recently restored from CD-ROM may result in a dialog stating “Access Violation.” This happens if
the session (and its audio files) are marked with the Read-Only flag. If you do not know how to remove the Read-Only flag
from your files, please consult Windows Help.

Sibelius Does Not Launch when Using the Send to Sibelius Command (ltem #110405)

When you first install any of the supported Sibelius packages (Sibelius, Sibelius First, or Sibelius Student), the Send to Sibelius
command in Pro Tools will return a false error stating that Sibelius is not installed in the system. To avoid this problem,
launch Sibelius manually and create a score document. This will only needs to be done once, after which the Send to Sibelius
command should function properly.
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When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic
Transposition, Transposition is Based on the First Key Signature in the Session Only (ltem #81666)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the
“Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can
be corrected by toggling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each
key.

MIDI Performance Affected by Adjusting Volume Knob on Unit During Playback (FireWire 1814 Only) (ltem #58159)

Changing the volume level on the M-Audio FireWire 1814 while in playback will make the recorded MIDI information stutter
and stall. To avoid this, close Pro Tools, launch the M-Audio Control Panel, set the output volume to O dB or to your prefer-
ence, and then disengage the Link button. In Pro Tools, your Master Fader (or separate track faders) now become your output
control.

MIDI Inputs and Output Seem to be Missing from the Screen, or Appear to Scroll off Screen (ltem #53611)

When the screen resolution is set to 1024x768, users with large MIDI configurations might notice MIDI inputs/outputs miss-
ing from the MIDI input/output routing pop-up dialogs. Resize the screen to a higher resolution to resolve this problem.

Unavailable MIDI Input Paths for MIDI and Instrument Tracks are not Indicated (Item #111221)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a ses-
sion on a system where the device or path are not actually present.

Elastic Audio

Changes to Elastic Audio Algorithms in Pro Tools 8.x (Iltem #109141)

Several changes have been made to Elastic Audio signal processing in Pro Tools 8.0 and higher. In some cases, you may notice
improvements with timing accuracy of events when time warping audio using the Polyphonic algorithm. In other cases, you
may notice sustained low frequency content sounds smoother when time stretching using the Rhythmic algorithm. The X-
Form algorithm was upgraded as well, and exhibits better pitch coherency on certain polyphonic audio sources. While the
aim was to improve sonic performance, it is important to note that sessions using Elastic Audio processing can sound differ-
ent when played in Pro Tools 8.x than the same sessions did in Pro Tools 7.4. To reproduce Elastic Audio processing identical
to Pro Tools 7.4, you can replace Elastic Audio version 8.0.1 with version 7.4 and commit your audio tracks if necessary. Note
that version 7.4 does not support Elastic Pitch.

Change Between Pro Tools 7.4 and 8.x in how Transient and Warp Markers Affect Sound Quality (ltem #105159)

Both the Polyphonic and Rhythmic Elastic Audio algorithms rely on transient analysis to achieve optimal fidelity and timing
accuracy. Reducing event sensitivity, and consequentially removing Analysis or Warp markers, may adversely affect the
sound quality and timing of elastic regions. Conversely, an overabundance of Analysis markers or Warp markers, can also ad-
versely affect sound quality. For best results, make sure that Analysis markers are reasonably correct vis a vis the musical
events in an audio region. Note that to achieve the highest sound quality, the Polyphonic algorithm in Pro Tools 8.x is more
reliant upon Analysis markers than in Pro Tools 7.4.

Unusual Audio “Warble” with Polyphonic Elastic Audio (Item #103038 and #108845)

In some cases, some audio that is being processed with the Polyphonic Elastic Audio algorithm may sound “warbly.” If this
occurs, try adjusting the Window Length control in the Polyphonic Elastic Audio Plug-in window until the warble goes away.
If you are opening a session that previously used the default Window Length setting in Pro Tools 7.4.x, which was 30 ms, a
recommended starting point would be 40 ms. 40 ms is also the new default parameter value for the Polyphonic Elastic Audio
algorithm in Pro Tools 8.x.
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Real-Time Elastic Audio Tracks Do Not Show Accurate Waveforms (ltem #98343)

When using Elastic Audio Real-Time Processing, Pro Tools displays the varispeed waveform in Waveform view no matter
which algorithm you are using. This is done because all of the Elastic Audio processing is done in real-time and the waveform
is a prediction of what it will sound like. Switching to Rendered mode will give you an actual representation of the audio as
rendered by the algorithm you are using.

Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (ltem #89026)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAYV or .AIF),
but the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Cal-
culate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported
format. To check the file’s format, look at the Format column in the Workspace browser. If a file format other than WAV or
AIFF is shown (such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-sup-
ported files can still be previewed in tempo, as well as elasticized once imported into a session.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (ltem #96151)

Drift in an audio region may occur when using elastic audio depending on how much the regions is expanded or compressed
when using the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient in-
formation in it that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (Iltem #106002)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Mono-
phonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio
Pitch processing from the track before switching to the Monophonic or Varispeed algorithm.

Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Region Groups in Rendered Mode to Fall
Offline (Item #97993)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause region groups in Rendered mode to fall of-
fline. The workaround is to make an edit to the offline region and then toggle the Elastic Audio from rendered to real-time
and then back to rendered.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (ltem #96725)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported
at Session Tempo only. This preference option will not function unless Preview In Context is enabled in Workspace, and/or
“Drag and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (Item #111299)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will
need to manually select the correct timebase for the affected tracks.

Elastic Audio Regions on Playlist Lanes Are Not Rendered (Item #111882)

In Playlists View, any Elastic Audio regions on Playlist lanes are not rendered (waveform is “off-line”) when changing the
track’s Elastic Audio processing from Real-Time to Rendered.

Region Groups Containing Elastic Audio Are Not Recognized as Elastic if the Region Group Itself Has Not Had Any Elastic
Functions Applied (Item #92770, #97107)

If a region group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level
of the region group itself, then the region group will not register as Elastic Audio. When used to create a new track, the track
will not automatically be Elastic Audio—enabled, and the elastic audio inside the region group will be rendered using the de-
fault Elastic Audio plug-in for the session. As a workaround, add a warp marker to the region group to force it to register as
an elastic region. Or, create an Elastic Audio-enabled track first, then add the region group to it.

Pro Tools M-Powered 8.0.1 on Windows — 9/1/09 9



Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (ltem #96404)

Use Copy from Source Media to import Elastic Audio tracks.

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (Item: 111064)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio
and inner-region asynchronous transients issues). This is inherent with compressed file formats.

Plug-ins
For known issues about specific plug-ins, see the Digidesign Plug-ins Read Me.

AudioSuite and Region Groups (ltem #64410)

AudioSuite plug-ins handle Region Groups in the Region List slightly differently than audio files. With audio files, an Audio-
Suite process can be applied to all copies of a unique audio file which appear in your session by selecting your target as Region
List in the AudioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the Audio-
Suite plug-in window while you have a Region Group selected, Pro Tools does not recognize the Region Group as processable
audio and will present a No Audio was Selected error. This is because a Region Group is not treated as audio until it is actually
used in a track.

To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:

1 Select the Region Group to be processed.
2 From the Region List menu, select Ungroup All. All elements of the group will remain selected.
3 Perform AudioSuite processing.

4 From the Region List menu, select Regroup.

When prompted, select Modify to apply the AudioSuite Process to all copies of the Region Group in the session, or Copy to
apply it only to the selected Region Group.

MIDI Outputs to Some Software Synthesizer Plug-ins Are Italicized in Cross-Platform Sessions (ltem #54173)

With some software synthesizers, MIDI output ports show up italicized when opening a session on a different computer plat-
form than the session was created on until you re-assign the outputs.

Expired Demo Plug-ins

Using a demo plug-in whose trial period has ended may result in an “Illegal Instruction Attempted” error within Pro Tools M-
Powered. Removing the expired demo plug-ins from your Plug-in folder will rectify the situation.

Pace InterLok Plug-in Authorization Lost in NTFS Boot Drives with Long Names

If your system contains one or more drive(s) formatted with NTES, and which have drive names longer than 11 characters,
corruption of InterLok plug-in and M-Powered authorizations may occur. In order to remedy this issue before corruption can
occur, rename NTFS volumes to drive names that are 11 characters or less before installing or launching Pro Tools M-Pow-

ered. Should you attempt to launch Pro Tools M-Powered with NTES drives longer than 11 characters, a dialog should appear
alerting you to this fact.

Plug-in Find and Relink with File Types not Supported by Pro Tools (Iltem #111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to
file types that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the
file types used in plug-ins must also be supported by Pro Tools.
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Video

Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 (Item #109076)

Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at
4:3 or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To workaround this prob-
lem, render the movie letterbox natively within the 720x486 pixel dimension.

Video Playback Performance

When Movie > Highest Priority Playback is enabled, clicking on menus may affect video playback.

General Localization

Relinking Using MacDrive Version 6 to Open Sessions from Other Platform (Item #65528)

MacDrive version 6 strips the extensions off of files in “Normal Use” mode - you need to use “Backup/File Transfer” mode to
avoid having the extensions stripped off. However, “Backup/File Transfer” doesn't work well with multibyte characters, as
“International Use” does. “International Use” also strips the extensions, so you either have to not use multibyte characters,
or have the trouble with stripping extensions. These used to be separate options in MacDrive 5, but in 6 you can't get one
without the other. To get around the stripping extensions, you can do a Relink by ID only, and have it search through all the
files to match them up - this is the only workaround.

Pro Tools M-Powered Will Not Launch when Using M-Powered USB Devices with Traditional Chinese Windows XP on a Dell
650 Machine (ltem #72094)

Pro Tools M-Powered will fail to launch with M-Audio USB devices on Dell 650 machines with Traditional Chinese
Windows XP if the original Dell 650 sound driver is installed with the M-Audio USB driver. The workaround is to uninstall
the original Dell 650 sound driver, so that the M-Powered USB sound driver is the only driver on the system.

AAF/OMF Sequences with Non-English Characters Import with Garbled Region Names or Won't Relink
(Iltems #95851, #95857, #96279)

If an AAF/OMF sequence containing files or region names with non-English characters is exported from a Mac-based

Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, XP-based Pro Tools systems, or
Pro Tools 7.4 systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any
Pro Tools 7.4 system (or higher) may not import correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the
files, select “Manually Find and Relink,” then deselect all options except “Find by file ID.” Region names may appear garbled.

Error Messages

“DAE Error -6006” when Launching Pro Tools after Recording Audio via S/PDIF 9-10 Inputs (ltem #58585)

If you see a DAE error —6006 when launching Pro Tools, it means that the Firewire driver for your M-audio device has failed
to launch. Should this happen, power off the Firewire device, wait 15 seconds, power the device on again, wait another 15 sec-
onds, then launch Pro Tools again.

Error -6031 During Playback (Item #32637)

If you encounter a-6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the
session, quit and re-launch Pro Tools, then re-open the session before resuming playback.

DAE Error -9131

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools M-Powered 6.8.
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DAE Error -9132

If a-9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks
to the appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.

Corrections to Pro Tools Guides

What’s New Guides
Part Number 9320-59102-00 REV A 11/08

The following identifies corrections to and omissions from both the What’s New in Pro Tools LE and M-Powered 8.0 Guide.

Time Locking Regions

On page 38 of the What’s New in Pro Tools LE and M-Powered 8.0 Guide, the keyboard shortcut tip for Time Locking regions in-
correctly states, “Press Shift+T to Time lock or unlock the selected region.”

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the
selected region.”

Pro Tools Reference Guide
Part Number 9106-59126-00 REV A 11,/08

The following identifies corrections to and omissions from the Pro Tools Reference Guide.

Toolbar Focus
On page 25 of the Pro Tools Reference Guide, documentation of Toolbar focus is incorrectly omitted.
Corrections:

The following section for “Toolbar Focus” should be added right after the section on “Keyboard Focus:”

Toolbar Focus

In the Edit window, the MIDI Editor pane can be displayed in addition to the Tracks pane (View > Other Displays > MIDI Editor).
When the MIDI Editor pane is displayed, there are two separate Toolbars and Timelines in the Edit window: one for the Tracks
pane and one for the MIDI Editor pane. Only one Toolbar and Timeline can be focused for Menu and Toolbar commands (in-
cluding the corresponding keyboard shortcuts) at a time. The focused Toolbar displays a orange outline.

If Keyboard Focus for the Edit window is enabled, it follows the selected Toolbar focus.

To enable Toolbar focus for the Tracks pane, do one of the following:
= Click the Toolbar at the top of the Edit window.

= Press Control+Alt+4 (Windows) or Command+Option+4 (Mac).

To enable Toolbar focus for the MIDI Editor pane, do one of the following:
= Click the Toolbar right above the MIDI Editor pane.

= Press Control+Alt+5 (Windows) or Command+Option+5 (Mac).
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Pro Tools LE System Capabilities

On page 34 of the Pro Tools Reference Guide, the final paragraph incorrectly states, “Pro Tools LE systems provide up to 128
Auxiliary Input tracks, a total of 32 internal mix busses, and up to 5 inserts and 10 sends per track (depending on your com-
puter’s processing capacity). In addition, Pro Tools LE systems support up to 32 Instrument tracks and 256 MIDI tracks.

Pro Tools LE also supports a single QuickTime video track.”

Corrections:

The paragraph should read, “Pro Tools LE systems provide up to 128 Auxiliary Input tracks, a total of 32 internal mix busses,
and up to 10 inserts and 10 sends per track (depending on your computer’s processing capacity). In addition, Pro Tools LE sys-
tems support up to 32 Instrument tracks and 256 MIDI tracks. Pro Tools LE also supports a single QuickTime video track.”

Zoom Toggle Preferences

On page 90 and also on page 455 of the Pro Tools Reference Guide, the paragraph on the “Separate Grid Settings When Zoomed
In"” preference incorrectly states:

Separate Grid Settings When Zoomed In When selected, this option retains the same (current) grid setting when zoom tog-
gling in or out. When this option is deselected, the grid setting stored with Zoom toggle is recalled when zoom toggling in.

Corrections:

The paragraph should read:

Separate Grid Settings When Zoomed In When selected, the Grid setting stored with Zoom toggle is recalled when zoom tog-
gling in. When this option is deselected, the same (current) grid setting is used whether zoom toggling in or out.

Notes View for MIDI and Instrument Tracks

On page 435 of the Pro Tools Reference Guide, the ability to use a mouse with a scroll wheel to scroll up or down in Notes View
is omitted.

Corrections:

The following step should be added to the procedure for scrolling the Notes display up or down for a MIDI or Instrument
track: “If you have a mouse with a scroll-wheel, move the cursor over the track and Control-Alt-Start-scroll (Windows) or
Command-Option-Control-scroll (Mac) up or down to scroll the notes display up or down.”

Time Locking Regions

On page 731 of the Pro Tools Reference Guide, the keyboard shortcut tip for Time Locking regions is incorrectly states, “Press
Shift+T to Time lock or unlock the selected region.”

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the
selected region.”

Dragging and Dropping Plug-in Settings Files

On page 891 of the Pro Tools Reference Guide, the section on “Dragging and Dropping Plug-in Settings Files” erroneously states
that you can drag and drop plug-in settings files from Windows Explorer or the Mac Finder to inserts and plug-in windows.

Corrections:

The section on “Dragging and Dropping Plug-in Settings Files” should read:

To insert a plug-in by drag and drop:

» Drag and drop a plug-in settings file from a DigiBase browser to an Insert in the Mix (or Edit) window.
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To change a plug-in preset by drag and drop:

= Drag and drop a plug-in settings file from a DigiBase browser to the plug-in window. The plug-in settings file must be for
the same plug-in name. For example, you cannot replace a 1-Band EQ 3 with a plug-in setting for 4-Band EQ 3.

Menus Guide
Part Number 9329-52920-00 REV A 11/08

Track Menu

On page 33 of the Pro Tools Menus Guide, the following menu items are not available (however, the keyboard shortcuts for
these items remain functional):

¢ Solo Tracks with a Selection
e Mute Tracks with a Selection
e Record Arm Tracks with a Selection

e Input Monitor Tracks with a Selection (Pro Tools HD Only)
Corrections:

The entire “Solo, Mute, Record Arm, and Input Monitor Tracks with a Selection Commands” section should be deleted.

Trillium Lane Labs Plug-ins Guide
Part Number 9329-59303-00 REV A 11,/08

Introduction
The TL Labs AutoPan™ is incorrectly listed as a paid plug-in, but it is included free and installed with Pro Tools 8.0.1.
Corrections:

TL Labs AutoPan should be listed under Free Trillium Lane Labs Plug-ins and should be deleted from under Paid Trillium Lane
Labs Plug-ins.
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